Smaart v8.2 Quick Start
Smaart v8.2 includes an overhaul and expansion of Smaart’s sound level measurement features, including
integration with 10EaZy sound level measurement hardware, expanded meter functionality, SPL History
window, and a comprehensive log file. This Quick Start assumes a working knowledge of v8.1. For a full list of
new features, and detailed feature descriptions, please refer to the help files within Smaart.

Sound Level Calibration/Logging Workflow
Proper sound level calibration is required to make use of most of the new features in 8.2. It is also necessary
to enable Logging if you want to use the SPL History window with a live input.
Begin by choosing the desired input device and channel in I-O Config. If the input is not already calibrated for
sound level measurement, select the channel that needs calibration and click the Calibrate button at the
bottom of I-O Config. Proceed with calibration, referring to the section below if you are unfamiliar with the
process.
Note: 10EaZy Class 1 and Class 2 systems are calibrated from the factory, so you can skip that step if your
system was calibrated recently.
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Calibrating for Sound Level Measurements
To calibrate Smaart for sound level measurements, open the
Amplitude Calibration dialog window using the Config
program menu, the Calibrate button in the I-O Config, or by
right-clicking an SPL Meter and choosing “Calibrate”.
Make sure the Input Device and channel selections
correspond to the microphone that you wish to calibrate.
Attach your calibrator to the microphone and turn it on, then
click the Calibrate button. The Calibration Progress dialog
appears as Smaart measures the signal level over a period of
several seconds. When the progress bar reaches 100%, make
sure the number in the "Set this value to" field matches the
output level of your calibrator or change it if necessary, then
click OK to apply the change and exit the dialog.
Back in the Amplitude Calibration dialog, click the OK button
to exit. The input should now be properly calibrated for sound
level measurement.

Next, click the SPL Log Config button at the bottom of I-O Config. The SPL Log Config opens and the SPL
Config tab is brought into focus at the same time.

“Operator”, “Company”, and “Venue” are optional informational fields that are added to the header of each
log file. Enter something useful, then choose the calibrated inputs you wish to log using the tree view at the
bottom of the dialog. Checking the box next to the device name selects all calibrated inputs for that device.
Click OK to close the dialog.
You may choose to configure SPL Meters for display at this time, but you can also do this after logging begins;
the SPL Meters are a view of the sound level measurements that are calculating and logging in the
background. The following items must be configured prior to the start of logging, as they will be greyed when
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logging begins: Logging Interval, Log Path, User Leq Time, Alarm settings, and 10EaZy Limit, Weight, and
Period (when applicable).

When you’re ready, click Start Logging in the top-right section of SPL Config. Smaart is now calculating all
supported sound level metrics in the background.

New Features
10EaZy Integration
Smaart 8.2 includes support for communicating with and measuring through the 10EaZy SPL measurement
hardware, developed by SG Audio Aps. During 8.2 installation, the 10EaZy hardware drivers are automatically
installed on your computer (Mac OS and Windows are supported). 10EaZy can be used for all single-channel
measurements in Smaart. For more information about 10EaZy hardware, visit http://www.10EaZy.com

Note: The 10EaZy/Smaart integration features are only available for 10EaZy Class 1, Class 2, and RT systems.
The 10EaZy SW dongle is not supported.
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Multiple Systems
Smaart can interface with multiple 10EaZy systems if they are connected to the same computer via the
onboard USB ports or a powered external USB hub. The 10EaZy Maximum Average Manager (MAM)
implementation in Smaart can reference one 10EaZy microphone at a time. To monitor the SPL from multiple
systems simultaneously, simple create a standard SPL Meter for each 10EaZy input.

Maximum Average Manager (MAM) with dedicated Leq meter
A dedicated Leq meter and Maximum Average Manager meter is provided for the 10EaZy microphone. When
10EaZy is connected, an additional settings group becomes available in the SPL Config (previously Meter
Config) tab of the Configurator. The MAM is tied to the SPL Meters window, so you must show the SPL Meter
window (E hotkey) to see the MAM.

Sound Level Calculation Centralization
When an input is calibrated for sound level measurements, and logging is enabled or an SPL meter is
displayed, Smaart automatically begins calculating 14 sound level metrics for that input regardless of which
meters are actually showing.
The 14 sound level metrics are:
•
•
•
•
•
•
•
•
•
•
•
•
•
•

dB FS
dB SPL Fast
dB A SPL Fast
dB C SPL Fast
dB SPL Slow
dB A SPL Slow
dB C SPL Slow
Leq1
LAeq1
LCeq1
LeqT (where T is a user-defined time period)
LAeqT
LCeqT
Peak C

This provides a way to easily log and monitor SPL/Leq without taking up screen real estate, and without the
risk of resetting Leq buffers while reconfiguring SPL Meters.
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Comprehensive SPL Log File
Each logged input has a dedicated, time-stamped log file containing 13 sound level metrics (dBFS is not
logged). Additional logged data includes Input Clips, Alarms, Leq Reset, and a dedicated 10EaZy Leq column if
the logging device is 10EaZy.
When Smaart is closed, an informational header is written to the top of the log file containing various postanalysis results.

Logged SPL Data
The data section of the log file contains 21 columns:
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Time – date/time when logging occurred
10EaZy LXeq T – only present with 10EaZy inputs at the time of logging
Peak C Max – C weighted Peak SPL
SPL Fast Max – unweighted dB SPL Fast maximum value since last log entry
SPL A Fast Max – dBA SPL Fast maximum value since last log entry
SPL C Fast Max – dBC SPL Fast maximum value since last log entry
SPL Slow Max – unweighted dB SPL Slow maximum value since last log entry
SPL A Slow Max – dBA SPL Slow maximum value since last log entry
SPL C Slow Max – dBC SPL Slow maximum value since last log entry
Leq1 – 1 minute unweighted Leq at the time of logging
LAeq1 – 1 minute A weighted Leq at the time of logging
LCeq1 – 1 minute C weighted Leq at the time of logging
Leq1 C – A – LAeq value subtracted from LCeq value at the time of logging
Leq T – user-period unweighted Leq at the time of logging
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•
•
•
•
•
•
•
•

LAeq T – user-period A weighted Leq at the time of logging
LCeq T – user-period C weighted Leq at the time of logging
Leq T C – A – user-period LAeq value subtracted from LCeq value
dB FS Max – dB FS maximum value since last log entry
Overload – * in cell if input was clipped since last log entry
Alarm 1 – * in cell if Alarm 1 was triggered since last log entry, empty otherwise
Alarm 2 – * in cell if Alarm 2 was triggered since last log entry, empty otherwise
Leq Reset – * in cell if reset was triggered since last log entry, empty otherwise

SPL History Window
The SPL History window is a standalone window that shows a graphical presentation of the log file generated
from log-enabled inputs.
The SPL History window can be accessed from the View Menu (View -> SPL History), the hotkey combo
[Alt+H], or selecting SPL History from within the SPL Config tab of the Configurator. When SPL History is
visible, it is listed in the Window menu along with other program windows.
Active log files (real time) or previously generated log files can be viewed in the SPL History window. The SPL
History window contains two plots where the top (primary) plot shows the full log file and is always
displayed, and the secondary plot shows either the full log, or some portion of it designated by the zoom
widgets in the primary plot.
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Source Selection
The Source Selection drop-list contains a list of all logging inputs (friendly names), as well as a “File…” option,
located at the bottom of the list. When a live logging input is selected, the previously logged data is loaded
from the log file into the history plot and the plot commences updating from the current time.
Selecting the “Browse” button opens a file browser where you can choose to load a saved log file. Choosing
“File…” from the source selection drop-list also pops the file browser.

Plot Zoom Widgets
The primary plot contains arrow-shaped widgets that control what part of the log file is displayed in the
secondary plot. Moving either widget “crops” the trace viewed in the secondary plot to the area between the
widgets. When the widgets are resized to an area smaller than the entire log file (as pictured below), click
anywhere between the widgets and drag to move the zoom region. This acts like a magnifying glass, where
the secondary plot is displaying the magnified zoom region. You can also move the zoom region using the left
and right arrows on your keyboard. For live logs, if the right-most widget is positioned at the far right of the
plot it will lock onto the current time, giving you the ability to continuously view the most recent “x” minutes
of logged data in the secondary plot.

Plot Legend
The SPL History plots contain a Display Legend analogous to the Real Time plot Graph
Legend, however rather than showing static or live measurements, the legend is
populated by the 13 available SPL display metrics (dBFS is excluded). Only one metric
can be displayed in the primary plot at any time. The secondary plot supports
showing all or many of the available metrics by checking the colored boxes in the
plot legend. Clicking the name of the SPL metric will bring the corresponding trace to
the top of the trace stack. The Z hotkey can be used to cycle the trace stack order in
the secondary plot, which will update the trace displayed in the primary plot.
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Max, L10, L50, L90
These values are calculated from the logged data for the top-metric in the area within the zoom range.
Changing the metric z-order recalculates these values for the new top metric.
o

Max: The maximum value in the zoom range.

o

L10: The level exceeded for 10% of the time. For 10% of the time, the sound or noise has a sound
pressure level above L10. For the rest of the time, the sound or noise has a sound pressure level at or
below L10. (These higher sound pressure levels are probably due to sporadic or intermittent events.)

o

L50: The level exceeded for 50% of the time. It is statistically the mid-point of the noise readings. It
represents the median of the fluctuating noise levels.

o

L90: The level exceeded for 90% of the time. For 90% of the time, the noise level is above this level. It
is generally considered to be representing the background or ambient level of a noise environment.

Separate Input Meters and SPL Meters
Input Meters and SPL Meters are now independent standalone windows. Input Meters are automatically
configured based on selected devices and inputs, and can be toggled using the Shift + E hotkey. A horizontal
orientation has been added to Input Meters, toggled using hotkey Alt + Shift + E or via the menu at View ->
Input Meters -> Input Meter Orientation. The aspect ratio lock has been removed from Input Meters, making
the window more flexible.

Polarity Invert
The polarity of an input can be inverted using the  button near the corresponding Input
Meter. Engaging this setting inverts the polarity of the signal at the input level, effecting all
measurements using that input in Smaart.
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SPL Alarms and SPL readout colors
Two customizable SPL Alarms can be configured in the lower portion of SPL Config. When an alarm is active,
the chosen calibrated input is monitored using the selected SPL metric and alarm level. If the level is
exceeded, the border of the SPL Meters window flashes red and “Alarm 1 – X dB” is displayed in the title bar
for the configured duration. If logging is enabled on the input, the alarm is recorded in the log file.

In the SPL Display Settings area of the SPL Config, there are three SPL thresholds that control the color of SPL
meter readouts: Green Above, Yellow Above, and Red Above. If the value displayed in an SPL meter exceeds
one of these thresholds, the readout color will change to reflect the threshold color. These colors serve as
visual aids and SPL readout color changes are not recorded in the log file.
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